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1. Цель и задачи освоения дисциплины 
 

 
Цель 

освоения 

дисциплины 

получение студентами теоретических знаний и практических навыков в области 

технологии мультимедиа, интерактивной компьютерной графики, программно- 

аппаратной организации мультимедиа-компьютеров, а также освоение методов 

создания анимированных графических файлов, в том числе учебного характера, flash- 

анимированных роликов и компьютерного видеомонтажа. 

 

 
 
Задачи 

дисциплины 

Изучение теоретических, методологических и практических проблем технологии 

мультимедиа, плоскостной и 3-D компьютерной графики, анимации, аудио-, видео-, и 

их использование во всех сферах профессиональной деятельности. 

Освоение студентами методов обработки текстовой, графической, звуковой и видео 

информации. 

Приобретение навыков работы с современным программным обеспечением для 

проектирования и работы с разнородными данными (графикой, текстом, звуком, 

видео). 

2. Место дисциплины в структуре ОПОП 
 

Блок 1 «Дисциплины (модули)» 

Дисциплины и практики, знания и умения по 

которым необходимы как "входные" при 

изучении данной дисциплины 

Информатика 

Математика 

Дисциплины, практики, ГИА, для которых 

изучение данной дисциплины необходимо как 

предшествующее 

Маркетинг 

Моделирование и управление 

3. Требования к результатам освоения дисциплины 

Компетенции обучающегося, формируемые в результате освоения дисциплины. 
Степень сформированности компетенций 

 

Компетенции/ 

ЗУВ 

Планируемые результаты 

обучения 
Критерии оценивания ФОС 

ОПК7 способностью решать стандартные задачи профессиональной деятельности на основе 

информационной и библиографической культуры с применением информационно- 

коммуникационных технологий и с учетом основных требований информационной безопасности 

Знать - теоретические основы 
преобразования аналоговой 
информации в цифровую и 
наоборот; - основные типы и 
форматы файлов растровой и 
векторной графики; - основные 
технологии получения обработки 
цифрового аудио и видео; - 
подходы к созданию анимации и 
её основные виды; - требования к 
аппаратным средствам, которые 
используются для создания 
мультимедиа продуктов. 

Студент: - знает целостное 
представление о основах 
преобразования аналоговой 
информации в цифровую и 
наоборот; - знает основные типы и 
форматы файлов растровой и 
векторной графики; - знает 
основные технологии получения 
обработки цифрового аудио и 
видео; - знает подходы к созданию 
анимации и её основные виды; - 
знает требования к аппаратным 
средствам, которые используются 
для создания мультимедиа 
продуктов. 

Тест 



Уметь - разрабатывать мультимедиа 
продукты; - создавать и 
редактировать элементы 
мультимедиа; - размещать 
мультимедиа продукты в сети 
Internet; - применять 
мультимедиа технологии для 
решения задач 
профессиональной деятельности. 

Студент умеет: - разрабатывать 
мультимедиа продукты; - 
создавать и редактировать 
элементы мультимедиа; - 
размещать мультимедиа продукты 
в сети Internet; - применять 
мультимедиа технологии для 
решения задач профессиональной 
деятельности. 

Лабораторная 

работа 

Владеть - навыками рабочего 
проектирования 
мультимедийных объектов; - 
навыками обработки 
мультимедийной информации; - 
инструментальными средствами 
создания и модификации 
мультимедийных объектов; - 
навыками оформления 
полученных результатов с 
помощью средств компьютерной 
графики и видеомонтажа; - 
современными 
инструментальными средствами 
создания, модификации и 
просмотра мультимедийного 
продукта. 

Студента владеет: - навыками 
рабочего проектирования 
мультимедийных объектов; - 
навыками обработки 
мультимедийной информации; - 
инструментальными средствами 
создания и модификации 
мультимедийных объектов; - 
навыками оформления 
полученных результатов с 
помощью средств компьютерной 
графики и видеомонтажа; - 
современными 
инструментальными средствами 
создания, модификации и 
просмотра мультимедийного 
продукта. 

Лабораторная 

работа 

ПК11 владением навыками анализа информации о функционировании системы внутреннего 

документооборота организации, ведения баз данных по различным показателям и формирования 

информационного обеспечения участников организационных проектов 

Знать -этапы и технологию создания 
мультимедиа продуктов; 

-требования информационной 
безопасности при создании 
мультимедиа продуктов. 

Студент: -знает этапы и 
технологию создания мультимедиа 
продуктов; 

-знает требования 
информационной безопасности 
при создании мультимедиа 
продуктов. 

Тест 

Уметь -осуществлять визуализацию 
данных с использованием 
программных средств 
компьютерной графики общего и 
специального назначения; 

-осуществлять оптимизацию 
подсистемы аудиовизуального 
представления информации с 
применением профессиональных 
пакетов мультимедиа, 
компьютерной графики, 
анимации, видео. 

Студент умеет: -осуществлять 
визуализацию данных с 
использованием программных 
средств компьютерной графики 
общего и специального 
назначения; 

-осуществлять оптимизацию 
подсистемы аудиовизуального 
представления информации с 
применением профессиональных 
пакетов мультимедиа, 
компьютерной графики, анимации, 
видео. 

Лабораторная 

работа 



Владеть -навыками визуализации данных 
с использованием программных 
средств компьютерной графики 
общего и специального 
назначения; 

-навыками обработки и 
представления информации с 
применением профессиональных 
пакетов мультимедиа, 
компьютерной графики, 
анимации, видео. 

Студент владеет навыками: - 
визуализации данных с 
использованием программных 
средств компьютерной графики 
общего и специального 
назначения; 

-обработки и представления 
информации с применением 
профессиональных пакетов 
мультимедиа, компьютерной 
графики, анимации, видео. 

Лабораторная 

работа 

 

4. Структура и содержание дисциплины 

Тематический план дисциплины 
 

№ Название темы Содержание 
Литера- 

тура 

Формируемые 

компетенции 

1. Введение. Основы физиологии органов чувств человека, виды 9.1.1, ОПК7 Знать 
 Основные информации. Основные понятия, истоки и 9.2.1, ОПК7 Уметь 
 понятия эволюция компьютерной графики и 9.2.2, ОПК7 Владеть 
 графической мультимедийных технологий. Multimedia art: 9.2.3, ПК11 Знать 
 информации и хеппенинг, перформанс, инсталляция, 9.2.4, ПК11 Уметь 
 мультимедийных энвайронмент, синергия ощущений, 9.1.2 ПК11 Владеть 
 технологий. креолизованные тексты, цветомузыка, синестезия,   

 Органы чувств и стереокинематограф, мультипликация, видео-арт,   

 виды компьютерная мультимедийная технология,   

 информации. современные области применения мультимедиа.   

 Характеристика, Линейное и структурное представление   

 возможности и мультимедиа-информации. Мультимедийные   

 области приложения – энциклопедии, архивы,   

 применения интерактивные обучающие курсы, компьютерные   

 мультимедийных игры, Интернет-приложения, тренажеры,   

 приложений электронные средства торговой рекламы,   

  электронные презентации и др.   

2. Мультимедийные Классификация и характеристика основных видов 9.2.5, ОПК7 Знать 
 технологии и mass-media. Использование мультимедийных 9.2.6, ОПК7 Уметь 
 средства массовой технологий в учебном процессе, полиграфии, 9.2.7 ОПК7 Владеть 
 и межличностной радиотрансляции и радиовещании, цифровом  ПК11 Знать 
 коммуникации кинематографе, телевидении, Интернет.  ПК11 Уметь 

    ПК11 Владеть 



3. Аппаратные Реализация аппаратных модулей мультимедиа 9.2.2, ОПК7 Знать 
 средства системы. Базовый и расширенный комплект 9.2.3, ОПК7 Уметь 
 мультимедийных мультимедиа-компьютера. Графические адаптеры и 9.2.8, ОПК7 Владеть 
 технологий. акселераторы. Звуковые карты. Устройства 9.2.9 ПК11 Знать 
  накопления информации. Устройства ввода  ПК11 Уметь 
  информации, эргономичные клавиатуры, сканеры,  ПК11 Владеть 
  манипуляторы, графические планшеты,   

  микрофоны, цифровые фото - и видеокамеры.   

  Устройства виртуальной реальности. Устройства   

  отображения информации, их технические   

  характеристики. Виды устройств печати.   

  Устройства воспроизведения звука. Основы   

  компьютерного проектирования конечного   

  продукта. Этапы работы с оригинал-макетом   

  печатной графики и экранной аудиовизуальной   

  продукцией. Понятие брифа мультимедийного   

  проекта, литературного и режиссерского сценария,   

  экспликации.   

4. Общие сведения о Цифровая фотография и растровая графика. 9.1.3, ОПК7 Знать 
 компьютерной Разрешение оригинала, экранного и печатного 9.2.10, ОПК7 Уметь 
 графике и её изображения. Методы растрирования печатного 9.2.2, ОПК7 Владеть 
 видах. изображения. Линеатура растра. Методы 9.2.3 ПК11 Знать 
 Особенности интерполяции растровых изображений.  ПК11 Уметь 
 компьютерной Векторизация объектов растровой графики.  ПК11 Владеть 
 графики в Достоинства и недостатки растровой графики.   

 мультимедийных Компьютерная геометрия и векторная графика.   

 технологиях. Объекты-примитивы: линии, многоугольники,   

 Форматы окружности, кривые Безье, шрифт. Понятие   

 графических сплайна. Фрактальная графика и самоподобные   

 файлов. структуры. Достоинства и недостатки растровой и   

 Аддитивные и векторной графики. Особенности компьютерной   

 субтрактивные графики в мультимедийных технологиях, ее виды и   

 модели описания способы реализации. Понятие анаглифной   

 цвета в стереографики, псевдостереоскопической графики,   

 мультимедийных тифлогафики, аромаполиграфии. Классификация и   

 технологиях обзор форматов графических файлов. Описание   

  форматов растровых и векторных графических   

  файлов TIFF, GIF, BMP, JPEG, AI, CDR, EPS, PDF   

  и др. Понятие сжатия графических файлов. Сжатие   

  файлов без потерь и с потерями. Цветовая модель   

  RGB. Ограничения модели RGB. Цветовые модели   

  CMY и CMYK. Ограничения модели CMY.   

  Цветовые модели HSB, HSL, Grayscale, LAB.   

  Индексированный цвет, работа с палитрой.   



5. Основы 

цифрового аудио 

в 

мультимедийных 

технология 

Общие сведения о технологии аудио. Аналоговое и 

цифровое представление звука. Запись и оцифровка 

звука. Квантование и дискретизация. Цифровая 

фильтрация звуковых сигналов. Аудионосители. 

Аудиокодеки и форматы аудиофайлов. Цифровые 

форматы. Общие сведения о стереофонии. Моно-, 

стерео- и квадрофония в мультимедийных 

технологиях. Средства и системы записи, 

воспроизведения и трансляции аудиозаписей. 

Звуковые редакторы. Риппинг. Мастеринг. 

9.2.11, 

9.1.4 

ПК11 Знать 

ПК11 Уметь 

ОПК7 Знать 

ОПК7 Уметь 

ОПК7 Владеть 

ПК11 Владеть 

6. Сущность Общие сведения о технологии видео. Общие 9.1.4, ПК11 Знать 
 видеозаписи в сведения о характеристиках видеосигнала. 9.2.12 ПК11 Уметь 
 мультимедийных Характеристики видеосигнала. Количество кадров  ОПК7 Знать 
 технологиях. в секунду. Чересстрочная развёртка. Разрешение.  ОПК7 Уметь 
 Основы Соотношение сторон экрана. Количество цветов и  ОПК7 Владеть 
 цифрового видео. цветовое разрешение. Битрейт или ширина  ПК11 Владеть 
 Видеозапись и видеопотока (для цифрового видео). Качество   

 компьютерный видео. Видеокодеки. Основные форматы видео   

 видеомотаж (AVI, MOV, MKW, SWF, MPG, 3GP). Методы   

  сжатия видеоинформации. Форматы цифрового   

  кодирования и сжатия: M-JPEG, MPEG-1, MPEG-2,   

  H.264, DivX, XviD. Съёмка видеороликов и   

  оборудование для видеозаписи. Видео конверторы.   

  Линейный и нелинейный видеомонтаж. Программы   

  нелинейного монтажа. Сервисы сохранения   

  потокового видео. Программы захвата видео с   

  экрана для создания учебных роликов.   

7. Компьютерная 3- Трехмерная графика и технология 3D 9.1.3, ПК11 Знать 
 D графика. моделирования. Классификация электронных 9.2.13 ПК11 Уметь 
 Построение и средств отображения информации. Преобразования  ОПК7 Знать 
 динамическое в трехмерном пространстве. Создание  ОПК7 Уметь 
 отображение многогранников и тел вращения. Параметры  ОПК7 Владеть 
 графических 3-D «Поворот» и «Вращение» объектов 3-D графики.  ПК11 Владеть 
 объектов Проецирование двумерных графических   

  изображений на поверхность 3-D объекта.   

  Получение реалистических 3D изображений.   

  Алгоритмы удаление скрытых линий и   

  поверхностей. Рендеринг. Расчет освещения.   

  Наложение текстур. Тени и полупрозрачные   

  объекты. ПО для построения и визуализации 3D   

  модели. VRML - язык моделирования виртуальной   

  реальности.   

8. Анимация Физиологический аспект зрительного восприятия 9.1.5, ПК11 Знать 
  движения. Виды анимации. Анимация по 9.2.14, ПК11 Уметь 
  ключевым кадрам, запись движения, процедурная 9.2.15 ОПК7 Знать 
  анимация, программируемая анимация. Методика  ОПК7 Уметь 
  создания GIF анимированных файлов. Понятие  ОПК7 Владеть 
  векторной FLASH-анимации. Создание  ПК11 Владеть 
  аудиовизуальных роликов. Работа с анимацией   

  посредством каскадных таблиц стилей (CSS).   

  Возможности JavaScript для создания анимации на   

  Web-страницы. Работа со слоями. Обработка   

  событий.   



Распределение бюджета времени по видам занятий с учетом формы обучения 
 

 
 

№ 

Контактная 

работа 

Аудиторные учебные занятия 
Самостоятельная 

работа занятия 

лекционного типа 

лабораторные 

работы 

практические 

занятия 

очная 
очно- 

заочная 
заочная очная 

очно- 

заочная 
заочная очная 

очно- 

заочная 
заочная очная 

очно- 

заочная 
заочная очная 

очно- 

заочная 
заочная 

1. 4 3 2 2 1 1 2 2 1 0 0 0 8 9 11 

2. 4 3 2 2 1 1 2 2 1 0 0 0 8 9 11 

3. 4 3 2 2 1 1 2 2 1 0 0 0 8 10 11 

4. 4 3 2 2 1 1 2 2 1 0 0 0 9 10 11 

5. 4 3 1 2 2 0 2 1 1 0 0 0 8 10 11 

6. 4 3 1 2 2 0 2 1 1 0 0 0 9 10 11 

7. 6 3 1 4 2 0 2 1 1 0 0 0 9 10 12 

8. 4 3 1 2 2 0 2 1 1 0 0 0 9 10 12 

 Промежуточная аттестация 

2 2 2 0 0 0 0 0 0 0 0 0 4 4 4 

Итого 36 26 14 18 12 4 16 12 8 0 0 0 72 82 94 

5. Методические указания для обучающихся по освоению дисциплины 

В процессе освоения дисциплины студенту необходимо посетить все виды занятий, предусмотренные 
рабочей программой дисциплины и выполнить контрольные задания, предлагаемые преподавателем 
для успешного освоения дисциплины. Также следует изучить рабочую программу дисциплины, в 
которой определены цели и задачи дисциплины, компетенции обучающегося, формируемые в 
результате освоения дисциплины и планируемые результаты обучения. Рассмотреть содержание тем 
дисциплины; взаимосвязь тем лекций и практических занятий; бюджет времени по видам занятий; 
оценочные средства для текущей и промежуточной аттестации; критерии итоговой оценки результатов 
освоения дисциплины. Ознакомиться с методическими материалами, программно-информационным и 
материально техническим обеспечением дисциплины. 

Работа на лекции 

Лекционные занятия включают изложение, обсуждение и разъяснение основных направлений и 
вопросов изучаемой дисциплины, знание которых необходимо в ходе реализации всех остальных 
видов занятий и в самостоятельной работе студентов. На лекциях студенты получают самые 
необходимые знания по изучаемой проблеме. Непременным условием для глубокого и прочного 
усвоения учебного материала является умение студентов сосредоточенно слушать лекции, активно, 
творчески воспринимать излагаемые сведения. Внимательное слушание лекций предполагает 
интенсивную умственную деятельность студента. Краткие записи лекций, конспектирование их 
помогает усвоить материал. Конспект является полезным тогда, когда записано самое существенное, 
основное. Запись лекций рекомендуется вести по возможности собственными формулировками. 
Желательно запись осуществлять на одной странице, а следующую оставлять для проработки учебного 
материала самостоятельно в домашних условиях. Конспект лучше подразделять на пункты, 
параграфы, соблюдая красную строку. Принципиальные места, определения, формулы следует 
сопровождать замечаниями. Работая над конспектом лекций, всегда следует использовать не только 
основную литературу, но и ту литературу, которую дополнительно рекомендовал лектор. 

Практические занятия 

Подготовку к практическому занятию следует начинать с ознакомления с лекционным материалом, с 
изучения плана практических занятий. Определившись с проблемой, следует обратиться к 
рекомендуемой литературе. Владение понятийным аппаратом изучаемого курса является 
необходимым, поэтому готовясь к практическим занятиям, студенту следует активно пользоваться 
справочной литературой: энциклопедиями, словарями и др. В ходе проведения практических занятий, 
материал, излагаемый на лекциях, закрепляется, расширяется и дополняется при подготовке 
сообщений, рефератов, выполнении тестовых работ. Степень освоения каждой темы определяется 



преподавателем в ходе обсуждения ответов студентов. 

Самостоятельная работа 

Студент в процессе обучения должен не только освоить учебную программу, но и приобрести навыки 
самостоятельной работы. Самостоятельная работа студентов играет важную роль в воспитании 
сознательного отношения самих студентов к овладению теоретическими и практическими знаниями, 
привитии им привычки к направленному интеллектуальному труду. Самостоятельная работа 
проводится с целью углубления знаний по дисциплине. Материал, законспектированный на лекциях, 
необходимо регулярно дополнять сведениями из литературных источников, представленных в рабочей 
программе. Изучение литературы следует начинать с освоения соответствующих разделов дисциплины 
в учебниках, затем ознакомиться с монографиями или статьями по той тематике, которую изучает 
студент, и после этого – с брошюрами и статьями, содержащими материал, дающий углубленное 
представление о тех или иных аспектах рассматриваемой проблемы. Для расширения знаний по 
дисциплине студенту необходимо использовать Интернет-ресурсы и специализированные базы 
данных: проводить поиск в различных системах и использовать материалы сайтов, рекомендованных 
преподавателем на лекционных занятиях. 

Подготовка к сессии 

Основными ориентирами при подготовке к промежуточной аттестации по дисциплине являются 
конспект лекций и перечень рекомендуемой литературы. При подготовке к сессии студенту следует 
так организовать учебную работу, чтобы перед первым днем начала сессии были сданы и защищены 
все практические работы. Основное в подготовке к сессии – это повторение всего материала курса, по 
которому необходимо пройти аттестацию. При подготовке к сессии следует весь объем работы 
распределять равномерно по дням, отведенным для подготовки, контролировать каждый день 
выполнения работы. 

6. Фонды оценочных средств для текущего контроля успеваемости, 

промежуточной аттестации и самоконтроля по итогам освоения дисциплины 

Технология оценивания компетенций фондами оценочных средств: 

формирование критериев оценивания компетенций; 

ознакомление обучающихся в ЭИОС с критериями оценивания конкретных типов оценочных 

средств; 

оценивание компетенций студентов с помощью оценочных средств; 

публикация результатов освоения ОПОП в личном кабинете в ЭИОС обучающегося; 

Тест для формирования «Знать» компетенции ОПК7 

Вопрос №1 . Пиксель является 

Варианты ответов: 

1. Основой растровой графики 

2. Основой векторной графики 

3. Основой фрактальной графики 

4. Основой трёхмерной графики 

Вопрос №2 . При изменении размеров растрового изображения 

Варианты ответов: 

1. качество остаётся неизменным 

2. качество ухудшается при увеличении и уменьшении 

3. при уменьшении остаётся неизменным а при увеличении ухудшается 

4. при уменьшении ухудшается а при увеличении остаётся неизменным 

Вопрос №3 . Что такое интерполяция 

Варианты ответов: 

1. разлохмачивание краёв при изменении размеров растрового изображения 

2. программа для работу в с фрактальными редакторами 

3. инструмент в Photoshop 



4. это слово не как не связано с компьютерной графикой 

Вопрос №4 . Наименьший элемент фрактальной графики 

Варианты ответов: 

1. пиксель 

2. вектор 

3. точка 

4. фрактал 

5. линия 

Вопрос №5 . Чем больше разрешение, тем …. изображение 

Варианты ответов: 

1. качественнее 

2. светлее 

3. темнее 

4. не меняется 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно от 0% до 30% правильных ответов из общего числа тестовых заданий 

Удовлетворительно от 31% до 50% правильных ответов из общего числа тестовых заданий 

Хорошо от 51% до 80% правильных ответов из общего числа тестовых заданий 

Отлично от 81% до 100% правильных ответов из общего числа тестовых заданий 

Лабораторная работа для формирования «Уметь» компетенции ОПК7 

Растровая графика (Работа со шрифтом, текстовые эффекты). 

Работа со шрифтом - интересная, многоплановая и достаточно сложная часть работы в компьютерном 

дизайне. Поэтому стоит рассмотреть различные дизайнерские приемы в создании текстовых эффектов. 

Надпись огнем 

Создайте файл произвольного размера (Ctrl+N). При этом проследите, чтобы цвет фона был черный, а 

в качестве цветовой модели (Color Mode) выбрана Grayscale (Полутоновый). Напишите 

текст hot белым цветом, шрифт Arial Bold. 

Если вас не устраивает размер или расположение надписи, то текст можно отредактировать прямо в 

окне изображения. Для этого нажмите сочетание клавиш Ctrl+T. Откроется окно, в котором 

устанавливается размер букв, положение надписи и ее наклон. 

Отредактировав текст, откройте палитру Layers (Слои). Ваше изображение должно содержать два слоя: 

фоновый слой и слой с текстом. Переведите текст в растр. Склейте слой с текстом и слой фона, для 

чего выполните команду Layer --> Merge Layers (Слой --> Склеить слои) или нажмите сочетание 

клавиш Ctrl+E. 

Поверните изображение на 90 градусов против часовой стрелки: Image -> Rotate Canvas -> 90 CCW 

(Изображение -> Повернуть холст -> 90 градусов против часовой стрелки). 

Примените фильтр Wind (Ветер): Filter -> Stylize -> Wind (Фильтр -> Стилизация -> Ветер). Установите 

следующие настройки фильтра: Method (Метод) - Wind (Ветер), Direction (Направление) - From the 

Right (Ветер справа). Для того, чтобы применить данный фильтр, и необходимо было вращать 

изображение. 

Чтобы увеличить язычки пламени, этот фильтр стоит применить несколько раз. 

Теперь примените к изображению фильтр Glass (Стекло): Filter -> Distort -> Glass (Фильтр -> 

Деформация -> Стекло). Установите следующие параметры: Distortion (Искажение) 1, Smoothness 

(Смягчение) 3, Texture (Текстура) Frosted, Scaling (Неравномерность) 100%. 



Верните изображение в исходное положение: Image -> Rotate Canvas ->90 CW (Изображение -> 

Повернуть холст -> 90 градусов по часовой стрелке). 

Теперь нужно придать пламени движения. Для этого воспользуйтесь фильтром Ripple (Рябь): Filter -> 

Distort -> Ripple (Фильтр -> Деформация -> Рябь). Установите средний (Medium) размер ряби (Size) и 

сделайте параметр Amount (Эффект) равным 100%. 

Пришло время раскрасить пламя. Переведите изображение в режим индексированных цветов: Image -> 

Mode -> Indexed Color (Изображение -> Режим -> Индексированные цвета). Затем Image -> Mode -> 

Color Table (Изображение -> Режим -> Палитра). Выберите таблицу Black Body. 

Готовый эффект показан на рисунке 1. 

2. Пишем льдом 

Создайте заготовку произвольного формата в режиме Grayscale (Полутоновый). Цвет фона должен 

быть белым, а цвет переднего плана - черным (данные цвета являются основными цветами по 

умолчанию, поэтому их можно установить, не переходя в цветовую палитру, нажатием клавиши D). 

Напишите текст frost, шрифт Century 

Откройте палитру Layer (Слой) и щелкните правой кнопкой мыши по слою с текстом. В появившемся 

меню выберите пункт Rasterize Layer (Растрировать слой). Затем склейте его с нижним слоем. 

Выделите текст волшебной палочкой, для чего выделите одну букву, затем щелкните по выделению 

правой клавишей мыши и выберите пункт Similar (Подобно). 

Выполните кристаллизацию надписи: Filter -> Pixelate -> Crystallize (Фильтр -> Оформление -> 

Кристаллизация). Установите размер ячейки кристаллизации равным 10. 

Так как ледяная поверхность не идеально гладкая, придадим ей шероховатость. 

Для этого следует добавить шум: Filter -> Noise -> Add Noise (Фильтр -> Шум -> Добавить шум). 

Задайте значение Amount (Эффект) равным 70 % и установите флажок Monochromatic (Монохромный). 

После выполнения вышеописанных действий должен получиться результат, изображенный на рисунке 

2. 

Смягчите эффект, полученный после кристаллизации и добавления шума, применив фильтр Gaussian 

Blur: Filter -> Blur -> Gaussian Blur (Фильтр -> Смазывание -> Смазывание Гаусса). Радиус размытия 

возьмите около 2. 

Следующий этап - цветокоррекция с использованием тоновых кривых. 

Выберите команду Image -> Adjustments -> Curves (Изображение -> Регулировки -> Кривые) или 

нажмите сочетание клавиш Ctrl+M. Попытайтесь нарисовать кривую, похожую на ту, которая 

изображена на рисунке 3. 

Теперь следует создать сосульки. Для этого выберите сначала команду Image -> Rotate Canvas -> 90 

CW (Изображение -> Повернуть холст -> 90 градусов по часовой стрелке), а затем Filter -> Stylize -> 

Wind (Фильтр -> Стилизация -> Ветер). Настройка фильтра Wind (Ветер): Method (Метод) - Wind 

(Ветер), Direction (Направление) - From the Right (Ветер справа). 

Верните холст в исходное положение командой Image -> Rotate Canvas -> 90 CCW (Изображение -> 

Повернуть холст -> 90 градусов против часовой стрелки). 

Теперь осталось раскрасить лед. Переведите изображение в цветовой режим RGB: Image -> Mode -> 

RGB Color (Изображение -> Режим -> RGB). Теперь выберите команду меню Image -> Adjustments -> 

Hue / Saturation (Изображение -> Регулировки -> Цвет / Насыщенность). Установите флажок Colorize 

(Тонирование) и следующие параметры: тон (Hue) 198, насыщенность (Saturation) 54, яркость 

(Lightness) 0. 

Для того, чтобы лед засверкал и заискрился, выберите инструмент Brush (Кисть) и активизируйте 

режим Airbrush Capabilities (Возможности аэрографа). Воспользуйтесь дополнительными кистями в 

виде звезд и снежинок для создания эффекта искрящегося и переливающегося на солнце льда. 

Итоговое изображение представлено на рисунке 4. 



 

Задания для самостоятельно работы: 

1. Составьте коллаж из фотографий на произвольную тему, добавьте в него надпись "огнем". Надпись 

должна гармонировать с общей темой коллажа. 

2. Создайте плкакт к мультфтильму "холодное сердце", вставьте надпись "льдом". 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Уметь» компетенции ОПК7 

 
Редактирование цифрового звука (Sound Forge 9.0) 

Sound Forge — набор инструментов для редактирования цифровых аудиофайлов, подходящий как для 

любителей, так и профессионалов. Sound Forge позволит получить полный контроль над процессом 

монтажа и мастеринга, производить запись, отладку и восстановление звука, записывать звуковые 

компакт-диски, кодировать и декодировать любые форматы аудио. 

 
Задание 

Смонтировать аудиозапись из двух медиафайлов с применением функции микширования, обработки 

звуковых дорожек и дополнительных звуковых эффектов. 
 

Порядок выполнения 

1. Загрузить медиафайл №1 в проект. 

2. Используя маркеры/области выделения выделить ряд отрезков аудиозаписи для их последующего 

удаления. 

3. Удалить выделенные отрезки. 

4. Загрузить медиафайл №2 в проект. 

5. Выделить в загруженном медиафайле отрезок, который впоследствии будет вставлен в медиафайл 

№1. 

6. Скопировать выделенный отрезок аудиозаписи. 

7. Вернуться к исходному файлу №1 и вставить отрезок аудиозаписи, скопированный из другого 

файла. 

8. Повторить пункты 5-6 с целью последующего применения функции микширования. 

9. Используя функцию микширования, наложите фрагмент одной композиции на другой. 

10. Применить обработку аудиозаписи: команды постепенного изменения уровня сигнала (увеличить 

и уменьшить) для начала и конца записи. 



11. Применить 2 дополнительных эффекта к получившейся аудиозаписи. 

12. Сохранить получившийся аудиофайл и показать его преподавателю. 

13. Подготовить отчет о выполнении лабораторной работы, используя «Документы Google». Открыть 

доступ к отчету преподавателю (с правами редактора). 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Уметь» компетенции ОПК7 

Видеомонтаж в программе Киностудия Windows Live 

Задания для практического занятия: 

Выполнить монтаж видеоролика из исходных материалов 

Инструкция по выполнению практической работы 

1. Запустите приложение Киностудия Windows Live. 

2. Вставьте видео в киностудию, нажав по кнопке «Добавить видео». Видео находится в папке с 

рабочими материалами.Видео сразу же встанет на раскадровку. 

3. Разбейте видео на 2 логически завершенные части. 

Для этого: 

выделите текущий клип; 

в проигрывателе клипа передвиньте бегунок на точку разделения клипа. 

Воспользуйтесь верхним меню Правка-Разделить. 

4. Можно сделать сразу несколько частей видео для добавления большого количества эффектов. 

5. Добавьте анимацию переходов от клипа к клипу: пункт меню Анимация. Можно выбрать любой 

понравившийся переход. 

6. Перейдите во вкладку «Визуальные эффекты». 

7. К первому клипу примените эффект Появление, а к последнему – Исчезновение. 

8. Добавьте эффекты к самим клипам. Для этого выберите любой эффект в строке меню. 

9. Можете добавить следующие эффекты в вашу нарезку: 

Горизонтальое отражение, 

Голубой оттенок, 

Исчезание в белый фон, 

Оттенок сепия, 

Точечное. 

10. Добавьте титры в конце фильма. 



Можно выбрать эффект «Появление титров». 

11. Выполните наложение мелодии на видео. Музыкальный фрагмент находится в аудиофайле в папке 

с материалами для урока. 

Для этого: 

сначала нужно приглушить стандартные звуки: Правка-Громкость видео-, и поставить ползунок на 

минимум; 

выберете аудиофайл: Главная-Добавить музыку.. 

Над видео появится ползунок со звуковой дорожкой, можно растянуть на всё видео или только на 

участок, который будет обработан. 

Для остальных участков можно аналогично включить звук или видео. Можно добавить любую другую 

мелодию или звук. 

12. Сохраняем проект. Главная- Сохранить фильм-Компьютер. 

Задания для самостоятельной работы: 

1. Создать небольшой учебный фильм включающий не менее 3 - 4 видео фрагментов; 

2. Добавить звуковое сопровождение (2-3 аудиофрагмента); 

3. Добавить статичные сцены в фильм. 

4. Добавить видеоэффекты и видео переходы; 

5. Добавить слайды с титрами. 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Уметь» компетенции ОПК7 

Создание покадровой анимации 

В данной лабораторной работе мы научимся создавать покадровую анимацию. 

Покадровая анимация − это анимация, полностью составленная из ключевых кадров. В ней вы сами 

определяете как содержимое кадра, так и его "длительность" (т. е. сколько таких статических кадров 

будет занимать изображение). 

Для этого нам необходимы небольшие навыки рисования. 

1. Открываем в программе Macromedia Flash новый файл (Ctrl+N). Во вкладке Properties 

(Свойства) (нижняя часть экрана) устанавливаем размеры фона 550x330 пиксел, цвет фона белый, 

частоту смены кадров оставляем по умолчанию 12 кадров в секунду. 

2. Сочетанием клавиш Ctrl+F8 открываем вкладку Создание новых символов (Create new symbol). В 

поле Name пишем название мувика Fish, выделяем мышкой в поле Type: Movie clip, нажимаем OK. 

3. В первом кадре с помощью инструментов Pencil (Карандаш) и Fill Color (Заливка) (расположены 



слева на панели инструментов) рисуем и закрашиваем рыбку. Чтобы настроить инструмент Заливка, 

необходимо открыть панель Color (Shift+F9) справа от рабочей области. 

4. Выделяем мышкой первый кадр нашей анимации и нажимаем F6, тем самым копируя содержимое 

первого кадра во второй. 

5. Переходим во второй кадр (он идентичен первому) и сдвигаем рыбку чуть-чуть вверх и вправо. Для 

поворота рыбки используем инструмент Free Transform (слева на панели инструментов). Включаем 

режим кальки (см. рис. ниже). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Повторяя действия 4 и 5 еще примерно раз 13, копируя предыдущий кадр, создавая новый, сдвигая 

изображение рыбки, получим такую последовательность (в режиме кальки): 

7. На данный момент у нас 15 кадров. Теперь надо развернуть рыбку, чтобы она плыла в обратном 

направлении. В кадрах 16-21 пытаемся прорисовать поворот рыбки, примерно так: 
 

 

 

 

 

8. С 22 по 30 кадр повторяем действия 4 и 5, передвигая рыбку влево. 

9. Сейчас у нас 35 кадров. Разворачиваем снова рыбку, но теперь уже в другую сторону. 

10. Переходим на основную сцену: 

11. Сочетанием клавиш Ctrl+L открываем библиотеку символов нашего проекта: 

12. Мышкой перетаскиваем Movie Clip с рыбкой в первый кадр основной сцены. И запускаем 

ролик: Ctrl+Enter. 

Обратите внимание! На основной сцене при выделении мувика с рыбкой объект выделяется голубой 

рамкой, а на панели Свойства отображаются свойства данного мувика. 

Сохраняем проект под именем fish1.fla (он пригодится нам для выполнения следующих двух работ). 

Морфинг 

1. Открываем проект fish1.fla (первая часть лабораторной работы). Начинаем оформлять фон. Для 

этого создаём дополнительный, называем его fon и мышкой переносим его под слой с рыбкой. Рисуем 

на нём прямоугольник (панель инструментов слева) с градиентной заливкой от зелёного цвета к 

белому. Цвет градиента выбираем на панели справа Color. 

2. Пытаемся изобразить дно водоема. Рисуем прямоугольник на новом слое fon1 и заливаем его 

градиентом от коричневого цвета с прозрачностью от 100 % к 0 %. 

3. Создаём еще один слой dno, на котором изображаем камушки различных форм и размеров. Можно 

использовать инструмент Oval (эллипс), деформируя эллипсы инструментом Selection (чёрная 



стрелочка − первый инструмент на панели инструментов). 

4. Создаём новый Movie Clip (Ctrl+F8) (имя даём произвольное), в первом кадре которого рисуем 

водоросль или что-то на неё похожее. Выделяем мышкой всё растение и для группировки всех веточек 

нажимаем Ctrl+G (объект выделится голубой рамочкой). 

5. Наконец-то мы дошли до морфинга. Морфинг − это преобразование одного объекта в другой за счёт 

генерации заданного количества промежуточных кадров. Мы создали первый ключевой кадр с 

водорослью. Теперь создадим еще один ключевой кадр. Выделяем мышкой 10-й кадр, нажимаем F6, 

копируя данные 1-го кадра. Выбираем инструмент Free Transform, щелкаем по водоросли в 10-м кадре, 

мышкой переносим центр чёрной рамки на низ стебля растения и поворачиваем на небольшой угол 

вправо, как на рисунке. 

6. Далее выделяем мышкой 1-й кадр, а на панели Properties в строке Tween: выбираем режим Motion. 

На временной шкале должна появиться стрелка от первого кадра к десятому. 

• Анимация формы − Tween Shape. 

• Анимация движения − Tween Motion. 

Принципиальное отличие между этими способами состоит в том, что в первом способе Flash работает с 

графикой как с набором графических примитивов (линий, дуг, окружностей, прямоугольников, заливок 

и т. д.), а во втором случае Flash будет работать только со сгруппированными объектами или 

символами. 

7. Выделяем мышкой 20-й кадр, нажимаем F6 и поворачиваем водоросль влево. В 30-м и 40-м кадрах 

(также нажимаем F6) поворачиваем растение влево. В 50-м кадре опять нажимаем F6 и возвращаем 

водоросль на место, как в 1-м кадре. В 10-м, 20-м, 30-м и 40-м кадрах на панели Properties в строке 

Tween: выбираем режим Motion. 

Поставьте мышку в 1-й кадр и нажмите Enter, посмотрите, как двигается водоросль. Если вас что-то не 

устраивает, то можно изменить угол наклона объекта в ключевых кадрах (1, 10, 20, 30, 40, 50). 

8. На основной сцене создадим еще один новый слой, назовем его vodorosli и перенесём на него 

несколько мувиков с водорослью. Расположим их в произвольном порядке на дне водоема. Можно 

изменить размер некоторых объектов или отобразить зеркально. 

9. Ролик готов! Нажимаем Ctrl+Enter и наслаждаемся анимацией. Не забудьте сохранить проект. 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Уметь» компетенции ОПК7 

СОЗДАНИЕ ПРИМИТИВОВ В 3DS MAX 

Общие сведения 

Все примитивы 3ds Max можно найти на вкладке Create (Создание) командной панели. На этой вкладке 



объекты разделены по категориям, а в рамках категорий – по группам. Всего доступно семь категорий: 

• Geometry (Геометрия); 

• Shapes (Формы); 

• Lights (Источники света); 

• Cameras (Камеры); 

• Helpers (Вспомогательные объекты); 

• Space Warps (Объемные деформации); 

• Systems (Дополнительные инструменты). 

Категория Geometry. Некоторые объекты приходится моделировать довольно часто. Например, если 

дизайнер занимается архитектурной визуализацией, ему приходится постоянно создавать такие 

объекты, как окна, двери, лестницы и т. д. Поскольку 3ds Max довольно часто используется для 

создания различных архитектурных проектов, разработчики добавили в эту категорию несколько 

групп объектов: 

• Doors (Двери) – содержит три типа объектов, напоминающих входные двери, двери автобуса и двери 

купе; 

• Windows (Окна ) – позволяет добавлять в сцену шесть разных типов окон, которые различаются по 

способу открытия; 

• Stairs (Лестницы) – используется для создания четырех разных типов лестниц: прямой, винтовой, L- 

образной и U-образной; 

• AEC Extended (Дополнительные объекты для АИК) – содержит объекты для создания стен, оград и 

растительности. 

Вспомогательные объекты. Вспомогательные объекты категории Helpers (Вспомогательные объекты) 

не позволяют создавать видимые трехмерные объекты, однако используются для ориентации в 

трехмерном пространстве. Например, благодаря инструменту Compass (Компас), трехмерное 

пространство получит ориентир. Независимо от того, в какой точке будет создан этот объект, его 

направление всегда будет одним и тем же. Когда строитель возводит дом, он часто делает замеры, 

определяя расстояние и угол между разными элементами. Для выполнения подобных операций 

используются два вспомогательных объекта – Tape (Рулетка) и Protractor (Угломер). Первый помогает 

определить расстояние между двумя точками, а второй – угол между линиями, соединяющими 

исходную точку и два объекта. Некоторые вспомогательные объекты предназначены для 

моделирования атмосферных эффектов в 3ds Max, таких как огонь, дым, туман и пр. Эти объекты 

представляют собой так называемый габаритный контейнер, или ограничитель объема виртуального 

пространства, в котором происходит тот или иной эффект. Подобные объекты относятся к группе 

Atmospheric Apparatus (Габаритный контейнер атмосферного эффекта). У некоторых объектов 

категории Helpers нет настроек – Dummy (Пустышка) представляет собой параллелепипед, который 

удобно использовать при создании анимации для связки нескольких объектов. Схожую функцию 

выполняет вспомогательный объект Point (Точка). 

Практическая часть 

1. Создайте стол с помощью стандартных примитивов – параллелепипеда (Box) и 4-х цилиндров 

(Cylinder). Для этого в проекции Top создайте столешницу из параллелепипеда. Центрируйте ее 

относительно координат X, Y, Z. Параметры установите самостоятельно. Затем добавьте ножки стола 

из цилиндров используя операции копирования и перемещения. Должно получиться аналогично 

рисунку 1 {горячие клавиши w – перемещение, e – вращение, r – масштабирование, q – выделение, z – 

фокусировка на выделенном объекте или сцене} 



 

Рис. 1. Изображение стола 

2. Создайте аналогичное изображение стола на основе улучшенных примитивов (Extended Primitives). 

Добавьте стул (рис. 2.). 

Рис. 2. Изображение сцены из улучшенных примитивов 

3. Добавьте изображение стены с окном на основе инструментов Plane (Плоскость) и Box. Используйте 

булевы операции. 

4. Добавьте чайник по центру поверхности стола и расставьте стулья вокруг стола. Предварительно 

сгруппируйте стул используя команды группировки: выделите в сцене объекты, которые нужно 

сгруппировать; выполните команду Меню ? Group ? Group; в диалоговом окне Group (Группировка) 

укажите название группы в поле Group name (Название группы). После группировки вокруг созданной 

группы появится единый габаритный контейнер вместо нескольких. 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Владеть» компетенции ОПК7 

СОЗДАНИЕ РАЗЛИЧНЫХ ЭФФЕКТОВ В PHOTOSHOP 

1. Штрих-код 

Создайте новое изображение (Ctrl+N) в любой цветовой модели. Размеры изображения должны быть 

небольшими - оптимально 300100 пикселов. Фоновый цвет - белый. 

В начале примените фильтр Add Noise: Filter -> Noise -> Add Noise (Фильтр -> Шум -> Добавить шум) 



с настройками, Количество — 400%, Распределение — Гаусс, Одноцветный. 

Превратите шум в полосы. Для этого примените фильтр Motion Blur (Смазывание движения) с 

настройками, Искажение — 90, Дистанция — 999. 

Результат последнего действия уже напоминает штрих-код, однако полосок слишком много, и они 

слишком тонкие. Для того, чтобы это исправить, увеличьте контраст изображения. Это можно сделать 

несколькими способами, но наиболее эффективным будет увеличение контраста с помощью кривых. 

Если все сделано правильно, результат будет похож на: 
 

Текстура готова. Однако для большей убедительности нужно выполнить еще два действия. 

Запустите инструмент Rectangle Marquee (Прямоугольное выделение), выделите фрагмент в нижней 

части изображения и нажмите клавишу Delete. 

После этого инструментом Horizontal Type (Горизонтальный текст) наберите в созданной области 

произвольный набор цифр. Шрифт и размеры подберите на глаз. Примените Brightness / Contrast 

(Яркость / Контраст). Готовое изображение показано на рисунке. 

2. Эффект Скорости 

Имитация скорости - это один из наиболее востребованных приемов в профессиональном дизайне. 

Дело в том, что скорость позволяет очень хорошо задать настроение работы или подчеркнуть те или 

иные качества рекламируемого предмета, а готовые фотографии такого содержания чрезвычайно 

редки. 

В данной лабораторной работе предлагается создать имитацию автомобиля, движущегося на большой 

скорости. 

Начните с крутящихся колес. Запустите инструмент Elliptical Marquee (Эллиптическое выделение) и 

выделите колесо. Затем примените фильтр Radial Blur (Радиальное размытие) из группы Blur 

(Размытие) с настройками, Amount— 30? Blur Method — Splin, Quality — Good. Затем повторите это 

действие для второго колеса. 

Выделите корпус автомобиля, применив наиболее удобный для вас инструмент выделения. Вырежьте 

полученную область на новый слой, для чего щелкните правой кнопкой мыши по фоновому слою и из 

контекстного меню выберите команду Layer via copy (Слой через копирование). 

Нижний из двух одинаковых слоев необходимо размыть. Для этого отлично подходит специальный 

фильтр: Filter -> Blur -> Motion Blur (Фильтр -> Смазывание -> Смазывание движения). 

Для имитации скорости необходимо передвинуть верхний слой так, чтобы два нижних образовывали 

не ореол, а "шлейф" позади движущегося объекта. Возможно, какие-то элементы корпуса придется 

затереть при помощи инструмента Eraser (Ластик). 

Однако, автомобиль, несущийся на огромной скорости без водителя - это достаточно нелепо. Поэтому 

дорисуйте контур головы человека при помощи кисти и немного размойте его. Установите в палитре 

Layers (Слои) параметр Opacity (Непрозрачность) 40 %. 

Результат представлен на рисунке. 

3. Кристаллы 

Создайте новое изображение размером 400400 пикселов в цветовом режиме RGB. Используя 

инструмент Paint Bucket (Заливка), залейте его черным цветом. 

Затем примените фильтр Lens Flare: Filter -> Render -> Lens Flare (Фильтр -> Освещение -> Блик) с 

настройками Brightness — 105%, Lens Type — 50-30mm Zoom. Обратите внимание на то, что блик 

должен быть расположен по центру изображения. 

Увеличьте при помощи Canvas Size: Image -> Canvas Size (Изображение -> Размер холста) размеры 

изображения в два раза. 

Теперь следует превратить блик в достаточно большое разноцветное пятно. Для этого воспользуйтесь 

фильтром Fresco: Filter -> Artistic -> Fresco (Фильтр -> Художественные -> Фреска). 



Сформируйте кристаллы. Для этого используйте фильтр Extrude: Filter -> Stylize -> Extrude (Фильтр -> 

Стилизация -> Выдавливание). Необходимые настройки изображены на рисунке. 

Окрасьте кристаллы в один тон. Для этого используйте инструмент Hue / Saturation (Оттенок / 

Насыщенность) в режиме Colorize (Окраска). Готовое изображение представлено на рисунке. 
 

Задание для самостоятельной работы: 

1. Создайте макет упаковки продукта (продукт выберите самостоятельно), обязательно вставьте 

штрихкод. 

2. Создайте макет постера фильма "Форсаж", добавьте эффект" скорость". 

3. Создайте макет рекламного постера десткого научного кружка, используйте изображения 

кристаллов. 

 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Владеть» компетенции ОПК7 

Кодирование и обработка звуковой информации с помощью звукового редактора Audacity 

1. В операционной системе Windows запустить звуковой редактор Audacity. 

2. Установим частоту дискретизации звука 22050 Гц и глубину кодирования звука 16 битов. Для этого 

в окне приложения ввести команду [Правка - Параметры...]. В диалоговом окне Параметры на 

вкладке Качество в соответствующих полях ввести частоту дискретизации и глубину кодирования. 

Запишем оцифрованный звук (при наличии микрофона) 

3. В окне приложения на панели инструментов щелкнуть по кнопке Записывать и с помощью 

микрофона начать запись звука. Для остановки записи щелкнуть по кнопкеОстановить. 

4. В окне приложения появится графическое отображение зависимости громкости записанного 

оцифрованного звука от времени. 

Поместим в программу оцифрованный звук 

5. В окне приложения на панели инструментов щелкнуть по кнопке [Файл - Открыть...] и указать путь 

к файлу Звук1.mp3. 

6. В окне приложения появится графическое отображение зависимости громкости записанного 

оцифрованного звука от времени. 

Ознакомимся с точками оцифровки, отображенными на графике зависимости громкости звука от 

времени. 

7. В окне приложения несколько раз ввести команду [Buд - Приблизить]. Шкала времени будет 



существенно растянута, и на графике станут видны точки оцифровки звука. После чего необходимо 

вернуть прежний масштаб. 

Осуществим редактирование оцифрованного звука: перенесем начальный фрагмент записи в ее 

окончание. 

8. На графическом отображении звуковой дорожки выделить с помощью мыши ее начальный 

фрагмент и ввести команду [Правка - Вырезатъ]. 

Установить курсор на конец записи и ввести команду [Правка - Вставить]. 

Прослушать отредактированную запись, щелкнув на панели инструментов по кнопке Воспроизвести. 

Применим к записи звуковые эффекты (Разворот, Смена скорости, Эхо и другие). 

9. Выделить весь фрагмент записи и ввести команды [Эффекты - Смена скорости...], [Эффекты - 

Эхо...], [Эффекты - Разворот] и другие. 

Прослушать результаты применения звуковых эффектов, щелкнув на панели инструментов по 

кнопке Воспроизвести. 

Осуществим наложение (микширование) двух записей. 

10. Записать вторую дорожку оцифрованного звука (см. п. 3) или открыть существующий звуковой 

файл командой [Проект – Импортировать звуковой файл...] 

Прослушать наложение двух записей, щелкнув на панели инструментов по кнопке Воспроизвести. 

Сохраним оцифрованный звук в звуковом файле на рабочий стол. 

11. Для сохранения оцифрованного звука в собственном формате звукового файла AUP ввести 

команду [Файл - Сохранить проект как...] и задать имя файла и его местоположение в файловой 

системе. 

12. Для сохранения оцифрованного звука в универсальном формате звукового файла WAV ввести 

команду [Файл - Экспортировать как WAV...] и задать имя файла и его местоположение в файловой 

системе. 

13. Для сохранения оцифрованного звука в формате звукового файла MP3 ввести команду [Файл - 

Экспортировать как MP3...] и задать имя файла и его местоположение в файловой системе. 

14. Сравнить информационные объемы звуковых файлов, сохраненных в различных форматах. 

Объясните полученный результат. 

15. При наличии свободного времени в записанном отдельно файле вырезать пустые части в начале и 

конце звукового файла, сохранив полученную запись на рабочий стол в формате Wav. 

Задания для самостоятельной работы 

1. Изучить основные понятия связанные с обработкой цифрового звука. 

2. Разбить файл с записью музыкального произведения на несколько файлов, в каждом из которых 

будет содержаться по одному куплету. 

3. Наложить голос на фоновую музыку. 

4. Использовать в работе не менее пяти фильтров 

 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 



 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Владеть» компетенции ОПК7 

Создание видеороликов в программе Windows Movie Maker 

Технология выполнения работы: 

1. Запустите Windows Movie Maker. Пуск – Программы - Windows Movie Maker 

2. Настройка интерфейса программы: проверьте меню Вид, активными являются (установлены 

флажки) пункты Панель инструментов, строка состояния, Панель задач. 

3. Рассмотрите в левой части окна Панель задач. Определите, какие задачи Windows Movie Maker 

позволяет выполнить. 

4. Займемся монтажом видеофильма. На панели задач выберите пункт Импорт изображений. 

Выберите папку Мои документы – Мои рисунки. И из любой тематической папки выберите 3 – 5 

графических файлов, удерживая кнопку CTRL, и щелкните кнопку Импорт. 

5. В центральной части окна на панели Сборник вы видите ваши выбранные графические файлы. 

Перенесите их последовательно один за другим в нижнюю часть экрана в окна раскадровки. 

6. Добавим эффекты рисунка. Для этого: Сервис – видеоэффекты. Просмотрите видеоэффекты и 

выберите любой понравившейся. Перенесите его на 1 кадр. В правой части окна располагается 

плеер, нажмите кнопку → (Воспроизведение). Просмотрите эффект в плеере. Аналогично 

примените эффекты следующим кадрам видеофильма. 

7. Между кадрами можно установить эффекты переходов. Для этого: Сервис – Видеопреход. В 

центральной части окна рассмотрите примеры видеопереходов. Выберите любой понравившейся, 

перенесите в нижнюю часть экрана на раскадровку и установите между двумя соседними 

кадрами. Аналогично установите видеопереходы для оставшихся кадров фильма. 

8. Просмотрите результат монтажа в плеере. Есть возможность предварительного просмотра фильма 

во весь экран. Для этого: Вид – Во весь экран. 

9. Добавим титульный кадр и финальный кадр фильма. Для этого: На панели задач выбираем 

пункт Создание названий и титров. Выбираем пунктДобавить название в начале фильма. Вводим 

название фильма. Измените анимацию текста, его шрифт и цвет. Поэкспериментируйте, 

просматривая предварительный результат в окне плеера. Примените выбранные свойства, 

щелкнув по кнопке Готово, добавить название в фильм. 

10. Создайте титры в конце фильма. Выполняйте операции самостоятельно, аналогично п. 9. 

11. Добавим звуковое сопровождение к фильму. На панели задач выбираем пункт Импорт звуки и 

музыки. Выбираем местонахождения звуковой информации. В нашем случае воспользуемся 

готовыми мелодиями, расположенными на сервере. Мое сетевое окружение – Соседние 

компьютеры - Great – Music и выбираем понравившуюся композицию. Перенесите звуковой файл 

на раскадровку. Звуковой файл оказался длиннее фильма, необходимо отрезать лишнее, для этого: 

подведите указатель мыши к крайнему правому положению звуковой ленты и удерживая 

переместите до нужного места (указатель принимает вид двойной красной стрелки). 

12. Сохраним созданный проект в виде фильма под своей фамилией. Для этого: Файл – Сохранить 

файл фильма - Мой компьютер – Далее – Введите имя файла, например, Попков_9а – выберите 

папку своей группы (класса), используя кнопку Обзор – Далее – Установите флажок в пункте – 

Воспроизвести фильм после нажатия кнопки готово. Нажмите кнопкуГотово. Подождите немного, 

фильм сохраняется в видеоформате. 

Задания для самостоятельной работы 



Создайте небольшой учебный фильм на свободную тему, предварительно согласовав ее с 

преподавателем. 

Требования к работе: 

1. Наличие не менее 3 - 4 видео фрагментов в составе фильма. 

2. Наличие звукового сопровождения (2-3 аудиофрагмента). 

3. Вставка статичных сцен (фотографий) в фильм. 

4. Применение видеоэффектов и видео переходов. 

5. Наличие слайдов с титрами. 

 

 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Владеть» компетенции ОПК7 

Анимация движения 

1. Откройте приложение Macromedia Flash 

2. Создайте новый фильм командой Файл - Новый 

3. В верхней части стола создайте изображение шара, при этом первый кадр на временной диаграмме 

будет помечен как ключевой (черной точкой). 

4. Инструментом Указатель, выделите шарик и сгруппируйте (объедините в одно целое) с помощью 

команды главного меню Изменить - Группировать. В результате шар окажется заключен в голубую 

выделяющую рамку: 

5. Щелкните правой кнопкой мыши на временной диаграмме в ячейке того кадра, который будет 

последним кадром анимации (например, 36-й), и в контекстном меню выберите команду Вставить 

ключевой кадр (Insert Keyframe): 

В результате промежуток между первым и последним ключевыми кадрами будет заполнен 

одноцветными (светло-серыми) ячейками простых кадров: 

6. В 36-м кадре перетащите шар на новую позицию в правой части стола, удерживая нажатой 

клавишу : 

7. Щелкните левой кнопкой мыши в ячейке первого ключевого кадра. Это приведет к одновременному 

выполнению двух действий: изображение шарика переместится на исходную позицию и изменится 

формат панели инспектора свойств – на ней будут представлены параметры выбранного (первого) 

кадра 

8. В панели инспектора свойств выберите в раскрывающемся списке Пара(Tween) пункт Motion: 

При этом формат панели изменится, и на ней появятся элементы интерфейса, позволяющие установить 

параметры анимации. 



Пока они нас не интересуют, значительно важнее изменения, произошедшие на временной диаграмме: 

первый и последний ключевые кадры теперь соединены стрелкой на сиреневом фоне. Это говорит о 

том, что создание анимации успешно завершено: 

9. Просмотрите готовый фильм. 

10. Готовое изображение сохраните в своей папке в формате *.fla 

Задания для самостоятельной работы 

Создать небольшой интерактивный анимированный флеш-ролик или «флеш-урок» на выбранную 

тему. 

При этом должны выполняться следующие условия: 

1. Продолжительность не менее 60 секунд; 

2. Использовать не менее трех сцен; 

3. Применить различные эффекты перемещения и трансформации; 

4. Применить эффекты анимации к тексту; 

5. Реализовать звуковое сопровождение и наличие альтернативных переходов. 

 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Владеть» компетенции ОПК7 

РЕДАКТИРОВАНИЕ КАРКАСНО-СЕТОЧНОЙ СТРУКТУРЫ 3D-ОБЪЕКТА 

1. Выберите из стандартных примитивов чайник. Войдите для него в режим Editable Mesh. Попробуйте 

отделить крышку и перевернуть ее так, как будто она упала. 

2. Видоизмените чайник так чтобы он стал более круглым (высоким, с дополнительными гранями, 

вогнутыми элементами). 

3. Добавьте скосы на окне из предыдущей лабораторной работы. Изогните ножки стола. 

4. Создание структурного объекта. 

На командной панели Create нажмите кнопку Shapes, выберите инструмент Rectangle и нарисуйте его в 

окне проекции Top. Перейдите на командную панель Modify и в свитке параметров введите значения 

36 в полях Length и Width. 

В списке модификаторов выберите вариант Extrude. Введите в поле Amount значение 60. В поле 

Segments введите значение 6, чтобы разбить башню по высоте на шесть сегментов. Снимите флажки 

Cap Start (Накрыть снизу) и Cap End (Накрыть сверху), чтобы удалить верхнее и нижнее основания 

объекта. 

В списке модификаторов выберите вариант Taper (Заострение). В поле Amount введите значение –0,5. 

В результате верхнее основание станет меньше нижнего. В списке модификаторов выбираем вариант 



Lattice (Решетка). Он позволяет превратить вершины и ребра в визуализируемые объекты. Отключите 

модификатор Taper. 

Из вкладки выберите геометрия объект GeoSphere. Создайте сферу радиусом 20. Нажмите кнопку 

Select Object (Выделить Объект) на главной панели инструментов и щелкните по башне. Выделите 

строчку Lattice в стеке модификаторов и, щелкнув правой кнопкой мыши, выберите команду 

копировать. В результате параметры модификатора будут скопированы в буфер. Выделите геосферу. 

Щелкните правой кнопкой мыши на строчке Geosphere в стеке модификаторов. Выберите в 

появившемся меню команду Paste Instanced (Вставить как образец). В результате, воздействующий на 

геосферу, будет иметь двустороннюю связь с оригиналом. Имя модификатора, отмеченного при этом 

курсивом, является образцом. Изменив значения модификатора Lattice на изображении геосферы он 

изменит параметры модификатора в изображении башни. 

В параметрах геосферы поставьте галочку на Struts Only from Edges (Только перемычки из ребер), 

чтобы убрать узлы из решетки в местах стыка ребер. В поле Radius из раздела Struts (Перемычки) 

введите значение 0,6, в поле Sides (Сторон) – значение 6. Во вкладке отображаемых модификаторов 

включите режим Make Unique, чтобы получилась независимая копия. Далее полученное изображение 

геосферы можно будет объединить с изображением башни. Далее опять работаем с башней. 

В окне модификаторов включите видимость модификатора Taper и перейдите к нему. Решетка 

исчезнет. Далее из списка модификаторов выбираем Edit Mesh (Правка сетки). Чтобы отобразить сетку 

выберите режим Edged Faces (Контуры граней). Можно щелкнуть правой кнопкой мыши в поле 

проекций, выбрать Object Properties, вкладку Display Properties, в ней установить флажок на Backlace 

Cull сняв галочку Edges Only, чтобы увидеть все смежные ребра. В режиме Edged Faces выбрать 

вариант Edge (Ребро). Выделяющей рамкой необходимо выделить все ребра, нажать в параметрах 

кнопку Visible (Видимый) и кнопку Show End Result on / off toggle (Показать конечный результат 

вкл/выкл). Снимите выделение с ребер. Под переключателем By Vertex установите флажок на Ignore 

Backfacing, чтобы выделять только видимые грани. В параметрах модификации нажмите кнопку Turn 

(Повернуть) и поменяйте ориентацию ребер. Кнопкой Divide (Разделить) можно добавить перегородки 

и ребра к будущей башне. Далее, выйдя из режима Edit Mesh, перейдите к Lattice в строке 

модификаторов. Должен получиться результат, показанный на рисунке 1 а. 

Попробуйте изменить параметры Заострения так, чтобы получилось изображение рисунке 1 б. 

5. Измените ножки стола, стульев. 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 



 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Тест для формирования «Знать» компетенции ПК11 

Вопрос №1 . Установите соотвествие 

Тип ответа: Соответствие 

Варианты ответов: 

1. Слои 

2. Библиотека 

3. Кадры 

4. Символы 

5. Шкала времени 

Варианты соответствий: 

1. Обеспечивают разделение объектов 

2. Отображают фазы движения 

3. Элементы многократного использования (элементы библиотеки) 

4. Содержит слои и кадры 

5. Хранилище объектов 

Вопрос №2 . Какие кадры называют ключевыми? 

Варианты ответов: 

1. Это кадры, которые используются в качестве опорных для генерации промежуточных кадров 

2. Это кадры, которые используются в качестве опорных для генерации порядочных кадров 

Вопрос №3 . Объекты сцены: 

Варианты ответов: 

1. квадрат, лупа, курсор 

2. куб, лампа, камера 

3. куб, шар, цилиндр 

4. окно, лампа, камера 

Вопрос №4 . 

Рендер является 

Варианты ответов: 

1. графическим редактором 

2. графическим отображением 3D сцены или объекта 

3. источником света 

4. отображением осей координат 

Вопрос №5 . Гиперссылка - это 

Варианты ответов: 

1. слово, группа слов или картинка, позволяющие осуществлять переход к другим документам или 

программам 

2. любое слово или любая картинка 

3. очень большой текст 



4. текст, использующий шрифт большого размера 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно от 0% до 30% правильных ответов из общего числа тестовых заданий 

Удовлетворительно от 31% до 50% правильных ответов из общего числа тестовых заданий 

Хорошо от 51% до 80% правильных ответов из общего числа тестовых заданий 

Отлично от 81% до 100% правильных ответов из общего числа тестовых заданий 

Лабораторная работа для формирования «Уметь» компетенции ПК11 

Лабораторная работа №1 

Создание буклета в InDesign 

Цель: изучить возможности программы InDesign 

Теоретические сведения 

Обычно буклеты изготавливаются на бумаге A4 или А3 формата. Буклетом считается печатная 

продукция, сфальцованная любым способом двумя и более сгибами. 

Рассмотрим буклет А4 формата, напечатав который нужно будет сделать сгиб двумя фальцами. Вид 

фальцовки у нас «раскладушка», давайте рассмотрим ее схему: 

 

Точные размеры границ в буклете для фальцовки следует уточнить в типографии, где он будет 

печататься и фальцеваться, это нужно для того, чтобы быть уверенным в правильном загибе буклета. 

Задание: 

Создать буклет - тема "кофе". 

Этапы создания буклета - образец техники выполнения 

1. Запустим программу InDesign. В окне запуска, в поле Create New выберем Document (Создать новый 



документ). 

2. В окне New Document выставим настройки: Number of Pages (Число страниц) – 2, в поле Page Size 

(Размер листа) выберем A4, Orientation (Ориентация) – горизонтально, Сolumns (Колонки) – 3, Gutter 

(Расстояние между колонками) – 8 мм., Margins (Поля) – 4 мм везде и Bleed (Блиды / Выпуск за обрез) 

по 2 мм. 

 

Откроется рабочая область нашего будущего буклета. Если нажать F12, выйдет палитра Pages, будут 

видны две страницы. 

3. Слева и вверху рабочей области видна линейка, если поставить на нее указатель мыши и потянуть - 



мы создадим направляющую. Выставим эти направляющие между колонками. 

4. В меню Window выберем палитру Mini Bridge, в ней удобно работать с файлами, если же у вас более 

ранняя версия, можно добавлять файлы с помощью File > Place (Поместить). На панели инструментов 

выберем инструмент "Фрейм" (Restangle Frame Tool). 

 

Начертим прямоугольник, далее в палитре Mini Bridge выберем папку, в которой будут находиться 

графические файлы для нашего буклета. 



5. Перетягиваем картинку во фрейм левой кнопкой мыши. Если она больше или меньше фрейма, жмем 

горячую клавишу Alt+Shift+Ctrl+E или заходим Object (Объект) > Fitting (Установка)> Fit Content 

Proportionally (Заполнить фрейм пропорционально). Также можно трансформировать картинку во 

фрейме "белой" стрелкой с нажатой клавишей Shift. 

6. С помощью инструмента «прямоугольник» рисуем фон квадратами различных оттенков, подобрав 

цвета с картинки с помощью инструмента «пипетка». 

 

Нажимаем F6 (открываем палитру "Цвет" (Color)) и регулируем цвета, вбивая их вручную или меняя 

оттенки с помощью ползунков. Сверху картинки накладываем еще один прямоугольник, задаем 

оттенок пипеткой с картинки или с помощью палитры Color, установим ему прозрачность 35%. 



 

7. На панели инструментов выберем инструмент Текст (Type Tool) 

и создадим текстовый блок, в моем случае "COFFee". Черной стрелкой можно трансформировать и 

вращать текст, если подвести стрелку к верхнему или нижнему уголку фрейма. Зайдем в меню Window 

> Type > Character или нажмем Ctrl+T. Отредактируем текст по своему вкусу, ...и зададим ему цвет в 

палитре Color (F6). 

8. Создадим текст по окружности. Выберем инстумент Эллипс,и начертим его вдоль блюдечка. 

 

Далее выберем инструмент "Текст по контуру" (Type on a Path), ...щелкнем по окружности и наберем 

текст. 



 

С помощью инструмента выделения (Selection Tool, белая стрелка) можно будет правильно направить 

текст по окружности. 

Убрать обводку у окружности можно будет также в палитре Color (F6). 

 

Не забываем периодически переключаться в режим Preview в нижней части панели инструментов, для 

более удобного отображения результата работы. 

9. Далее создадим текст с реквизитами. 



 

Снова выберем инструмент фрейм, и начертим прямоугольник 

и из MiniBridge перетащим картинку во фрейм, при необходимости заполним фрейм пропорционально 

(Alt+Shift+Ctrl+E). 

 

Также можно перемещать картинку во фрейме с помощью инструмента Selection Tool (белая стрелка). 

Таким образом создаем остальные картинки и располагаем как нам нравится. 



 

10. Создадим еще один текстовый блок. Выберем инструмент текст, укажим место где вставить текст, 

появится курсор и вставим из буфера обмена нужный нам текст. Выделим его, нажав Ctrl+A и откроем 

палитры Character (Символ) – Ctrl+T и Paragraph (Абзац) – Ctrl+M. В палитре Character выставим 

нужный размер и кегль, не забыв поставить в поле Language (Язык) – Русский, иначе не будут работать 

переносы. В палитре Paragraph выставим нужный абзац, также можно установить буквицу (Drop Cap 

Number of Lines) на 4 или 5 символов. 

11. Далее инструментом выделения (черная стрелка) жмем один раз левой кнопкой мыши на текстовый 

блок, и в верхней части окна находим настройки для тестового фрейма. При необходимости 

выставляем 2 колонки, расстояние – 3 мм и нажимаем на кнопку выравнивания текста между 

колонками. 



 

С этой страницей буклета справились, переходим к внутренней части буклета. Откроем палитру Pages 

(F12) и переместимся на вторую страницу. 

12. Здесь по аналогии с первым листом продолжаем работать над дизайном. Создаем фрейм, 

переносим из MiniBridge картинки в этот фрейм. Если надо выровнять растояние между фреймами - 

обращаемся к очень нужной палитре Align (Выравнивание) – Shift+F7. 

 

Также создадим еще прямоугольник в качестве фона для описания кофе, скопируем его несколько раз, 

и еще раз выровняем с помощью палитры Align (Выравнивание). 

Очень важно выравнивать объекты именно с помощью палитры Align, вручную не получится сделать 

все идеально ровно. 



 

13. Создадим текст, отредактируем его в палитре Character (Символ) – Ctrl+T и Paragraph (Абзац) – 

Ctrl+M. При желании можем создать стиль для каждого текста (заголовок, основной и тд.) вызвав 

палитру Paragraph Styles (Стили Абзаца) - F11. 

14. Продолжаем улучшать дизайн буклета. 

 

Переключимся в режим Preview, чтобы видеть как реально будет выглядеть буклет на печати. 



 

После того, как дизайн над буклетом полностью закончен, сохраним его в формате pdf, это наиболее 

оптимальный формат для передачи файла в типографию. 

15. Выберем File > Export и выберем тип файла Adobe PDF Print, нажмем Сохранить. Откроется окно 

настроек экспорта. Не буду долго описывать настройки экспорта, если вкратце, то достаточно в поле 

Adobe PDF Preset выбрать Press Quality - это оптимальная настройка по умолчанию для печати. Жмем 

Export. 

PDF-файл для печати готов, настоятельно рекомендую открыть его в Acrobat и внимательно 

рассмотреть, чтобы нигде ничего не испортилось при экспорте. 



Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Лабораторная работа для формирования «Владеть» компетенции ПК11 

РЕДАКТИРОВАНИЕ КАРКАСНО-СЕТОЧНОЙ СТРУКТУРЫ 3D-ОБЪЕКТА 

1. Выберите из стандартных примитивов чайник. Войдите для него в режим Editable Mesh. Попробуйте 

отделить крышку и перевернуть ее так, как будто она упала. 

2. Видоизмените чайник так чтобы он стал более круглым (высоким, с дополнительными гранями, 

вогнутыми элементами). 

3. Добавьте скосы на окне из предыдущей лабораторной работы. Изогните ножки стола. 

4. Создание структурного объекта. 

На командной панели Create нажмите кнопку Shapes, выберите инструмент Rectangle и нарисуйте его в 

окне проекции Top. Перейдите на командную панель Modify и в свитке параметров введите значения 

36 в полях Length и Width. 

В списке модификаторов выберите вариант Extrude. Введите в поле Amount значение 60. В поле 

Segments введите значение 6, чтобы разбить башню по высоте на шесть сегментов. Снимите флажки 

Cap Start (Накрыть снизу) и Cap End (Накрыть сверху), чтобы удалить верхнее и нижнее основания 

объекта. 

В списке модификаторов выберите вариант Taper (Заострение). В поле Amount введите значение –0,5. 

В результате верхнее основание станет меньше нижнего. В списке модификаторов выбираем вариант 

Lattice (Решетка). Он позволяет превратить вершины и ребра в визуализируемые объекты. Отключите 

модификатор Taper. 

Из вкладки выберите геометрия объект GeoSphere. Создайте сферу радиусом 20. Нажмите кнопку 

Select Object (Выделить Объект) на главной панели инструментов и щелкните по башне. Выделите 

строчку Lattice в стеке модификаторов и, щелкнув правой кнопкой мыши, выберите команду 

копировать. В результате параметры модификатора будут скопированы в буфер. Выделите геосферу. 

Щелкните правой кнопкой мыши на строчке Geosphere в стеке модификаторов. Выберите в 

появившемся меню команду Paste Instanced (Вставить как образец). В результате, воздействующий на 

геосферу, будет иметь двустороннюю связь с оригиналом. Имя модификатора, отмеченного при этом 

курсивом, является образцом. Изменив значения модификатора Lattice на изображении геосферы он 

изменит параметры модификатора в изображении башни. 

В параметрах геосферы поставьте галочку на Struts Only from Edges (Только перемычки из ребер), 

чтобы убрать узлы из решетки в местах стыка ребер. В поле Radius из раздела Struts (Перемычки) 

введите значение 0,6, в поле Sides (Сторон) – значение 6. Во вкладке отображаемых модификаторов 

включите режим Make Unique, чтобы получилась независимая копия. Далее полученное изображение 

геосферы можно будет объединить с изображением башни. Далее опять работаем с башней. 

В окне модификаторов включите видимость модификатора Taper и перейдите к нему. Решетка 



исчезнет. Далее из списка модификаторов выбираем Edit Mesh (Правка сетки). Чтобы отобразить сетку 

выберите режим Edged Faces (Контуры граней). Можно щелкнуть правой кнопкой мыши в поле 

проекций, выбрать Object Properties, вкладку Display Properties, в ней установить флажок на Backlace 

Cull сняв галочку Edges Only, чтобы увидеть все смежные ребра. В режиме Edged Faces выбрать 

вариант Edge (Ребро). Выделяющей рамкой необходимо выделить все ребра, нажать в параметрах 

кнопку Visible (Видимый) и кнопку Show End Result on / off toggle (Показать конечный результат 

вкл/выкл). Снимите выделение с ребер. Под переключателем By Vertex установите флажок на Ignore 

Backfacing, чтобы выделять только видимые грани. В параметрах модификации нажмите кнопку Turn 

(Повернуть) и поменяйте ориентацию ребер. Кнопкой Divide (Разделить) можно добавить перегородки 

и ребра к будущей башне. Далее, выйдя из режима Edit Mesh, перейдите к Lattice в строке 

модификаторов. Должен получиться результат, показанный на рисунке 1 а. 

Попробуйте изменить параметры Заострения так, чтобы получилось изображение рисунке 1 б. 

5. Измените ножки стола, стульев. 

 
Критерии оценки выполнения задания 

 

Оценка Критерии оценивания 

Неудовлетворительно 
Работа выполнена не полностью и объем выполненной части работы не 

позволяет сделать правильных выводов 

 
Удовлетворительно 

Работа выполнена не полностью, но не менее 50% объема, что позволяет 

получить правильные результаты и выводы; в ходе проведения работы были 

допущены ошибки 

 

Хорошо 

Работа выполнена в полном объеме с соблюдением необходимой 

последовательности действий, но допущена одна ошибка или не более двух 

недочетов и обучающийся может их исправить самостоятельно или с 

небольшой помощью преподавателя 

Отлично 
Работа выполнена в полном объеме без ошибок с соблюдением необходимой 

последовательности действий 

Вопросы для проведения промежуточной аттестации по итогам освоения дисциплины 

Тема 1. Введение. Основные понятия графической информации и мультимедийных технологий. 
Органы чувств и виды информации. Характеристика, возможности и области применения 
мультимедийных приложений 

1. Виды информации и способы ее восприятия органами чувств человека. 

2. Психофизиологические аспекты восприятия цвета и света 

3. Основные понятия компьютерной графики и мультимедиа. 

4. Мультимедиа приложения и их характеристики. 

Тема 2. Мультимедийные технологии и средства массовой и межличностной коммуникации 



5. Классификация мультимедиа. 

Тема 3. Аппаратные средства мультимедийных технологий. 

6. Виды аппаратных модулей мультимедиа. 

7. Виртуальная реальность, как вид мультимедиа. 

8. Основы компьютерного проектирования конечного продукта. 

9. Аппаратные решения в компьютерной графике и анимации. 

Тема 4. Общие сведения о компьютерной графике и её видах. Особенности компьютерной графики в 
мультимедийных технологиях. Форматы графических файлов. Аддитивные и субтрактивные модели 
описания цвета в мультимедийных технологиях 

10. Основные области применения компьютерной графики в мультимедиа технологии. 

11. Последовательность работы над графическим проектом. 

12. Растровая модель изображения. Основные характеристики растровых изображений. 

13. Достоинства и недостатки растровых изображений. 

14. Векторная модель изображения. Математические основы векторной графики. 

15. Достоинства и недостатки векторной графики. 

Тема 5. Основы цифрового аудио в мультимедийных технология 

16. Общие сведения о технологии аудио. 

17. Аналоговое и цифровое представление звука. 

18. Цифровые форматы. 

Тема 6. Сущность видеозаписи в мультимедийных технологиях. Основы цифрового видео. Видеозапись 
и компьютерный видеомотаж 

19. Характеристики видеосигнала. 

20. Качество видео. Видеокодеки. Основные форматы видео. 

21. Методы сжатия видеоинформации. Форматы цифрового кодирования и сжатия. 

22. Съёмка видеороликов и оборудование для видеозаписи. 

23. Программы захвата видео с экрана для создания учебных роликов. 

Тема 7. Компьютерная 3-D графика. Построение и динамическое отображение графических 3-D 
объектов 

24. Трехмерная графика и технология 3D моделирования. 

25. Проектирование разверток фигур-многогранников. 

26. Создание 3-D моделей тел вращения. 

27. ПО для построения и визуализации 3D модели. 

28. VRML - язык моделирования виртуальной реальности. 

Тема 8. Анимация 

29. Виды анимации. 

30. Методика создания GIF анимированных файлов. 

31. Понятие векторной FLASH-анимации. 

32. Создание аудиовизуальных роликов. 

Уровни и критерии итоговой оценки результатов освоения дисциплины 
 

 Критерии оценивания Итоговая оценка 

 

Уровень1. 

Недостаточный 

Незнание значительной части программного 

материала, неумение даже с помощью 

преподавателя сформулировать правильные 

ответы на задаваемые вопросы, невыполнение 

практических заданий 

Неудовлетворительно/Незачтено 



 

Уровень 2. 

Базовый 

Знание только основного материала, допустимы 

неточности в ответе на вопросы, нарушение 

логической последовательности в изложении 

программного материала, затруднения при 

решении практических задач 

Удовлетворительно/зачтено 

 

 
Уровень 3. 

Повышенный 

Твердые знания программного материала, 

допустимые несущественные неточности при 

ответе на вопросы, нарушение логической 

последовательности в изложении программного 

материала, затруднения при решении 

практических задач 

Хорошо/зачтено 

 

Уровень 4. 

Продвинутый 

Глубокое освоение программного материала, 

логически стройное его изложение, умение 

связать теорию с возможностью ее применения 

на практике, свободное решение задач и 

обоснование принятого решения 

Отлично/зачтено 

 

7. Ресурсное обеспечение дисциплины 
 

Лицензионное 

программно- 

информационное 

обеспечение 

1. Microsoft Windows (лицензионное программное обеспечение) 

2. Microsoft Office (лицензионное программное обеспечение) 

3. Google Chrome (свободно распространяемое программное обеспечение) 

4. Kaspersky Endpoint Security (лицензионное программное обеспечение) 

5. AnyLogic (свободно распространяемое программное обеспечение) 

6. ArgoUML (свободно распространяемое программное обеспечение) 

7. ARIS EXPRESS (свободно распространяемое программное обеспечение) 

8. Erwin (свободно распространяемое программное обеспечение) 

9. Inkscape (свободно распространяемое программное обеспечение) 

10. iTALC (свободно распространяемое программное обеспечение) 

11. Maxima (свободно распространяемое программное обеспечение) 

12. Microsoft SQL Server Management Studio (лицензионное программное 

обеспечение) 

13. Microsoft Visio (лицензионное программное обеспечение) 

14. Microsoft Visual Studio (лицензионное программное обеспечение) 

15. MPLAB (свободно распространяемое программное обеспечение) 

16. Notepad++ (свободно распространяемое программное обеспечение) 

17. Oracle VM VirtualBox (свободно распространяемое программное 

обеспечение) 

18. Paint .NET (свободно распространяемое программное обеспечение) 

19. SciLab (свободно распространяемое программное обеспечение) 

20. WinAsm (свободно распространяемое программное обеспечение) 

21. Консультант+ (лицензионное программное обеспечение отечественного 

производства) 

22. GNS 3 (свободно распространяемое программное обеспечение) 

23. Спутник (свободно распространяемое программное обеспечение 

отечественного производства) 

24. «Антиплагиат.ВУЗ» (лицензионное программное обеспечение) 

Современные 

профессиональные 

базы данных 

1. Консультант+ (лицензионное программное обеспечение отечественного 

производства) 

2. http://www.garant.ru (ресурсы открытого доступа) 

http://www.garant.ru/


Информационные 

справочные 

системы 

1. https://elibrary.ru - Научная электронная библиотека eLIBRARY.RU (ресурсы 

открытого доступа) 

2. https://www.rsl.ru - Российская Государственная Библиотека (ресурсы 

открытого доступа) 

3. https://link.springer.com - Международная реферативная база данных научных 

изданий Springerlink (ресурсы открытого доступа) 

4. https://zbmath.org - Международная реферативная база данных научных 

изданий zbMATH (ресурсы открытого доступа) 

Интернет-ресурсы 1. http://window.edu.ru - Информационная система "Единое окно доступа к 

образовательным ресурсам" 

2. https://openedu.ru - «Национальная платформа открытого образования» 

(ресурсы открытого доступа) 

3. https://wiki2.org/ru/Компьютерная_графика 

Материально- 

техническое 

обеспечение 

Лекции:  

Лаборатория информационных технологий в профессиональной 

деятельности, ауд.2.6: 

26 посадочных мест,  

Аудитория оснащенная оборудованием и техническими средствами обучения: 

- комплекты учебной мебели, 

- демонстрационное оборудование – проектор и компьютеры, 

- класс ПК, объединённых в локальную сеть, с выходом на эл.портал МФЮА 

 

Программное обеспечение: 

Microsoft Windows (Сублицензионный договор №Tr000153268 от 12-04-2017 

Microsoft Imagine Premium Renewed Subscription 3 year),  

Microsoft Office(Сублицензионный договор №Tr000235407 от 16-03-2018),  

Google Chrome (Свободно распространяемое ПО),  

Kaspersky Endpoint Security(стандартный Russian Edition 1000-1499 Node 2 

year Education Renewal License от 20-09-2018 до 21-11-2020). 

Информационно-справочная система «Консультант – плюс» (Договор об 

информационной поддержке от 27 декабря 2013 года) 

Браузер Спутник (Свободно распространяемое ПО) 

Практические занятия (Семинары): 

2.4 Кабинет информатики (компьютерный класс) 

 

32 посадочных мест,  

Аудитория оснащенная оборудованием и техническими средствами обучения: 

- комплекты учебной мебели, 

- демонстрационное оборудование – проектор и компьютеры, 

- класс ПК, объединённых в локальную сеть, с выходом на эл.портал МФЮА 

Программное обеспечение: 

Microsoft Windows (Сублицензионный договор №Tr000153268 от 12-04-2017 

Microsoft Imagine Premium Renewed Subscription 3 year),  

Microsoft Office(Сублицензионный договор №Tr000235407 от 16-03-2018),  

Google Chrome (Свободно распространяемое ПО),  

Kaspersky Endpoint Security(стандартный Russian Edition 1000-1499 Node 2 

year Education Renewal License от 20-09-2018 до 21-11-2020). 

Информационно-справочная система «Консультант – плюс» (Договор об 

информационной поддержке от 27 декабря 2013 года) 

Браузер Спутник (Свободно распространяемое ПО) 

https://elibrary.ru/
https://www.rsl.ru/
https://link.springer.com/
https://zbmath.org/
http://window.edu.ru/
https://openedu.ru/


Промежуточная аттестация: 

2.6 Учебная аудитория для проведения занятий лекционного типа, занятий 

семинарского типа, групповых и индивидуальных консультаций, текущего 

контроля и промежуточной аттестации,  

 

26 посадочных мест,  

Аудитория оснащенная оборудованием и техническими средствами обучения: 

- комплекты учебной мебели, 

- демонстрационное оборудование – проектор и компьютеры, 

- класс ПК, объединённых в локальную сеть, с выходом на эл.портал МФЮА 

Программное обеспечение: 

Microsoft Windows (Сублицензионный договор №Tr000705925 от 16-12-2021 

Microsoft Imagine Premium Renewed Subscription 3 year);  

Office 365 EDUA3 User A 1 Month(s) Academic Non-Specific EDU A3 

(Сублицензионный договор №Tr000693516 от 16-12-2021);Google Chrome 

(Свободно распространяемое ПО); Браузер Спутник (Свободно 

распространяемое ПО); Kaspersky Endpoint Security(стандартный Russian 

Edition 50-99 Node 2 year Education Renewal License от 30-09-2021 до 30-09-

2023); Электронная библиотека IPR-BOOKS, (Лицензионный договор № 

0612/21П от 17.08.2021, период окончания поддержки до 17.08.2024); 

AnyLogic(Свободно распространяемое ПО); ArgoUML(Свободно 

распространяемое ПО); ARIS EXPRESS(Свободно распространяемое ПО); 

Erwin (Свободно распространяемое ПО); Inkscape (Свободно 

распространяемое ПО); Maxima (Свободно распространяемое ПО); 

Microsoft SQL Server Management Studio(Свободно распространяемое ПО); 

MPLAB (Свободно распространяемое ПО); Notepad++ (Свободно 

распространяемое ПО);Oracle VM VirtualBox (Свободно распространяемое 

ПО); Paint .NET (Свободно распространяемое ПО); SciLab (Свободно 

распространяемое ПО); WinAsm (Свободно распространяемое ПО); GNS3 

(Свободно распространяемое ПО) 

Практические занятия (Семинары): 

2.4 Кабинет информатики (компьютерный класс) 

 

32 посадочных мест,  

Аудитория оснащенная оборудованием и техническими средствами обучения: 

- комплекты учебной мебели, 

- демонстрационное оборудование – проектор и компьютеры, 

- класс ПК, объединённых в локальную сеть, с выходом на эл.портал МФЮА 

Программное обеспечение: 

Microsoft Windows (Сублицензионный договор №Tr000153268 от 12-04-2017 

Microsoft Imagine Premium Renewed Subscription 3 year),  

Microsoft Office(Сублицензионный договор №Tr000235407 от 16-03-2018),  

Google Chrome (Свободно распространяемое ПО),  

Kaspersky Endpoint Security(стандартный Russian Edition 1000-1499 Node 2 

year Education Renewal License от 20-09-2018 до 21-11-2020). 

Информационно-справочная система «Консультант – плюс» (Договор об 

информационной поддержке от 27 декабря 2013 года) 

Браузер Спутник (Свободно распространяемое ПО) 
 

  



 

8. Учебно-методические материалы 
 

 
№ 

 
Автор 

 
Название 

 
Издательство 

 
Год 

издания 

 
Вид издания 

Кол-во 

в 

библио- 

теке 

Адрес 

электронного 

ресурса 

 
Вид 

доступа 

1 2 3 4 5 6 7 8 9 

9.1 Основная литература 

9.1.1 Хвостова 

И.П. 

Серветник 

О.Л. 

Вельц О.В. 

Компьютерная графика Северо-Кавказский 

федеральный 

университет 

2019 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/63097.html 

по 

логину 

и 

паролю 

9.1.2 Колесниченко 

Н.М. 

Черняева Н.Н. 

Инженерная и 

компьютерная графика 

Инфра-Инженерия 2018 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/78267.html 

по 

логину 

и 

паролю 

9.1.3 Забелин Л.Ю. 

Конюкова 

О.Л. 

Диль О.В. 

Основы компьютерной 

графики и технологии 

трехмерного 

моделирования 

Сибирский 

государственный 

университет 

телекоммуникаций и 

информатики 

2019 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/54792.html 

по 

логину 

и 

паролю 

9.1.4 Сидельников 

Г.М. 

Калачиков 

А.А. 

Цифровая обработка 

сигналов мультимедиа 

Сибирский 

государственный 

университет 

телекоммуникаций и 

информатики 

2020 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/74664.html 

по 

логину 

и 

паролю 

9.1.5 Торопова 

О.А. 

Кумова С.В. 

Анимация и веб-дизайн Саратовский 

государственный 

технический 

университет имени 

Ю.А. Гагарина, ЭБС 

АСВ 

2019 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/76476.html 

по 

логину 

и 

паролю 

9.2 Дополнительная литература 

9.2.1 Конакова 

И.П. 

Пирогова 

И.И. 

Инженерная и 

компьютерная графика 

Уральский 

федеральный 

университет, ЭБС 

АСВ 

2014 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/68429.html 

по 

логину 

и 

паролю 

9.2.2 Ваншина Е.А. 

Егорова М.А. 

Павлов С.И. 

Семагина 

Ю.В. 

Компьютерная графика Оренбургский 

государственный 

университет, ЭБС 

АСВ 

2016 учебно- 

методическое 

пособие 

- http://www. 

iprbookshop.ru 

/61891.html 

по 

логину 

и 

паролю 

9.2.3 Лейкова М.В. 

Бычкова И.В. 

Инженерная 

компьютерная графика. 

Методика решения 

проекционных задач с 

применением 3D- 

моделирования 

Издательский Дом 

МИСиС 

2016 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/64175.html 

по 

логину 

и 

паролю 

9.2.4 Хныкина А.Г. Инженерная и 

компьютерная графика 

Северо-Кавказский 

федеральный 

университет 

2016 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/69383.html 

по 

логину 

и 

паролю 

9.2.5 сост. 

Абалакова 

О.В. 

Мультимедийные 

технологии. Часть 1. 

Мультимедиа в 

современной 

социокультурной среде 

Кемеровский 

государственный 

институт культуры 

2014 учебно- 

методическое 

пособие 

- http://www. 

iprbookshop.ru 

/29686.html 

по 

логину 

и 

паролю 

9.2.6 Ли М.Г. Мультимедийные 

технологии. Часть 2. 

Мультимедиа в 

презентационной 

деятельности 

Кемеровский 

государственный 

институт культуры 

2014 учебно- 

методическое 

пособие 

- http://www. 

iprbookshop.ru 

/55247.html 

по 

логину 

и 

паролю 

9.2.7 Майстренко 

Н.В. 

Майстренко 

А.В. 

Мультимедийные 

технологии в 

информационных 

системах 

Тамбовский 

государственный 

технический 

университет, ЭБС 

АСВ 

2015 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/64124.html 

по 

логину 

и 

паролю 
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9.2.8 Разинкин 

В.П. 

Удалов В.Н. 

Основы цифровой 

аудио- и видеотехники. 

Часть 1 

Новосибирский 

государственный 

технический 

университет 

2010 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/45130.html 

по 

логину 

и 

паролю 

9.2.9 Разинкин 

В.П. 

Абросимов 

А.А. 

Основы цифровой 

аудио- и видеотехники. 

Часть 2 

Новосибирский 

государственный 

технический 

университет 

2011 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/45131.html 

по 

логину 

и 

паролю 

9.2.10 Куликов А.И. 

Овчинникова 

Т.Э. 

Алгоритмические 

основы современной 

компьютерной графики 

Интернет- 

Университет 

Информационных 

Технологий 

(ИНТУИТ), Ай Пи 

Ар Медиа 

2021 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/101990.html 

по 

логину 

и 

паролю 

9.2.11 Литвин С.А. 

Попов О.Б. 

Чернышева 

Т.В. 

Аудиопроцессорная 

обработка сигналов 

звукового вещания в 

каналах передачи 

Московский 

технический 

университет связи и 

информатики 

2016 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/61467.html 

по 

логину 

и 

паролю 

9.2.12 Катунин Г.П. 

Абрамова 

Е.С. 

Основы 

мультимедийных 

технологий. 

Видеомонтаж в Sony 

Vegas Pro 

Ай Пи Ар Медиа 2020 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/94279.html 

по 

логину 

и 

паролю 

9.2.13 Хохлов П.В. 

Хохлова В.Н. 

Погребняк 

Е.М. 

Информационные 

технологии в 

медиаиндустрии. 

Трёхмерное 

моделирование, 

текстурирование и 

анимация в среде 3DS 

MAX 

Сибирский 

государственный 

университет 

телекоммуникаций и 

информатики 

2016 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/74668.html 

по 

логину 

и 

паролю 

9.2.14 Вдовин А.С. Дизайн игр и 

медиаиндустрии. 

Персонажная графика и 

анимация 

Саратовский 

государственный 

технический 

университет имени 

Ю.А. Гагарина, ЭБС 

АСВ 

2015 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/76480.html 

по 

логину 

и 

паролю 

9.2.15 Петров А.А. Классическая анимация. 

Нарисованное движение 

Всероссийский 

государственный 

университет 

кинематографии 

имени С.А. 

Герасимова (ВГИК) 

2010 учебное 

пособие 

- http://www. 

iprbookshop.ru 

/30621.html 

по 

логину 

и 

паролю 

 

9. Особенности организации образовательной деятельности 

для лиц с ограниченными возможностями здоровья 

В МФЮА созданы специальные условия для получения высшего образования по образовательным 
программам обучающимися с ограниченными возможностями здоровья (ОВЗ). 

Для перемещения инвалидов и лиц с ограниченными возможностями здоровья в МФЮА созданы 
специальные условия для беспрепятственного доступа в учебные помещения и другие помещения, а 
также их пребывания в указанных помещениях с учетом особенностей психофизического развития, 
индивидуальных возможностей и состояния здоровья таких обучающихся. 

При получении образования обучающимся с ограниченными возможностями здоровья при 
необходимости предоставляются бесплатно специальные учебники и учебные пособия, иная учебная 
литература. Также имеется возможность предоставления услуг ассистента, оказывающего 
обучающимся с ограниченными возможностями здоровья необходимую техническую помощь, в том 
числе услуг сурдопереводчиков и тифлосурдопереводчиков. 

Получение доступного и качественного высшего образования лицами с ограниченными 
возможностями здоровья обеспечено путем создания в университете комплекса необходимых условий 
обучения для данной категории обучающихся. Информация о специальных условиях, созданных для 
обучающихся с ограниченными возможностями здоровья, размещена на сайте университета 
(http://www.mfua.ru/sveden/objects/#objects). 

Для обучения инвалидов и лиц с ОВЗ, имеющих нарушения опорно-двигательного аппарата 
обеспечиваются и совершенствуются материально-технические условия беспрепятственного доступа в 
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учебные помещения, столовую, туалетные, другие помещения, условия их пребывания в указанных 
помещениях (наличие пандусов, поручней, расширенных дверных проемов и др.). 

Для адаптации к восприятию обучающимися инвалидами и лицами с ОВЗ с нарушенным слухом 
справочного, учебного материала, предусмотренного образовательной программой по выбранным 
направлениям подготовки, обеспечиваются следующие условия: 

для лучшей ориентации в аудитории, применяются сигналы, оповещающие о начале и конце занятия 

(слово «звонок» пишется на доске); 

внимание слабослышащего обучающегося привлекается педагогом жестом (на плечо кладется рука, 

осуществляется нерезкое похлопывание); 

разговаривая с обучающимся, педагог смотрит на него, говорит ясно, короткими предложениями, 

обеспечивая возможность чтения по губам. 

Компенсация затруднений речевого и интеллектуального развития слабослышащих инвалидов и лиц с 
ОВЗ проводится за счет: 

использования схем, диаграмм, рисунков, компьютерных презентаций с гиперссылками, 

комментирующими отдельные компоненты изображения; 

регулярного применения упражнений на графическое выделение существенных признаков предметов 

и явлений; 

обеспечения возможности для обучающегося получить адресную консультацию по электронной 

почте по мере необходимости. 

Для адаптации к восприятию инвалидами и лицами с ОВЗ с нарушениями зрения справочного, 
учебного, просветительского материала, предусмотренного образовательной программой МФЮА по 
выбранной специальности, обеспечиваются следующие условия: 

ведется адаптация официального сайта в сети Интернет с учетом особых потребностей инвалидов по 

зрению, обеспечивается наличие крупношрифтовой справочной информации о расписании учебных 

занятий; 

в начале учебного года обучающиеся несколько раз проводятся по зданию МФЮА для запоминания 

месторасположения кабинетов, помещений, которыми они будут пользоваться; 

педагог, его собеседники, присутствующие представляются обучающимся, каждый раз называется 

тот, к кому педагог обращается; 

действия, жесты, перемещения педагога коротко и ясно комментируются; 

печатная информация предоставляется крупным шрифтом (от 18 пунктов), тотально озвучивается; 

обеспечивается необходимый уровень освещенности помещений; 

предоставляется возможность использовать компьютеры во время занятий и право записи 

объяснения на диктофон (по желанию обучающегося). 

Форма проведения текущей и промежуточной аттестации для обучающихся с ОВЗ определяется 
преподавателем в соответствии с учебным планом. При необходимости обучающемуся с ОВЗ с учетом 
его индивидуальных психофизических особенностей дается возможность пройти промежуточную 
аттестацию устно, письменно на бумаге, письменно на компьютере, в форме тестирования и т.п., либо 
предоставляется дополнительное время для подготовки ответа. 

 
Год начала подготовки студентов - 2020 


